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Introduction and Developmental Background 
Providing adequate amounts of appropriate habitat for species of interest is one of the 
many goals of forest owners and managers. Quality and quantity of habitat must be 
assessed, and its availability must be balanced with other identified needs from forests. 
Managers need tools to assess habitat trends and evaluate tradeoffs associated with 
existing habitat conditions and habitat management alternatives. The USDA Forest 
Service has spearheaded the creation of computer-based tools to help managers 
accomplish these tasks through the NED development effort. The NED software 
comprises a set of tools that enable a user to identify and inventory specific properties 
and management goals for those properties, then have the computer evaluate how well 
present or future conditions may meet those identified goals (Twery et al. 2005).  
MIWILD is an independent program from which the knowledge it contains will be added 
to the resources of forthcoming NED programs. MIWILD is a successor to NEWILD, a 
similar package published in 1998 (Thomasma et al. 1998) based on the compilations of 
species-habitat relationships by DeGraaf and Rudis (1986) and DeGraaf et al. (1992) for 
New England. 
 



 

 

The Wildlife Division of the Michigan Department of Natural Resources (MDNR) 
required a planning tool which would allow the user to assess impacts of forest 
management activities on wildlife and their habitats.  They were familiar with NEWILD 
but wanted a tool specific to the species and habitats of Michigan.  The resulting 
program, MIWILDhab was developed in a relatively short time, approximately 10 
months.  The information in the species/habitat matrices were the result of a rapid 
literature review and frequent discussions between the two biologists working on the 
project.  The original database was biased towards the forested habitats of the Upper 
Peninsula of Michigan.  MIWILDhab was subsequently used by MDNR Wildlife 
Division to assess management activities.  It has also been used by the Michigan Gap 
Analysis Program (GAP) for development of their products.   
 
Since MIWILDhab was first developed, the Forest Management Division of MDNR has 
changed their land-cover classification.  The land cover types used in MIWILDhab were 
forestry driven and the State has since moved to a new classification developed for The 
Integrated Forest Monitoring Assessment and Prescription (IFMAP) project.  The land 
cover classes in IFMAP were developed from classification of State-wide Landsat TM 
imagery.  The approximate number of land cover classes in MIWILDhab was 40 
compared to approximately 140 classes in IFMAP.  Because IFMAP included many more 
additional classes, and the original literature reviews in MIWILDhab were limited, the 
decision was made to refine MIWILDhab to utilize the classes developed for IFMAP, 
incorporate additional literature, and have a greater spatial application than just the Upper 
Peninsula of Michigan.  
 
MIWILD was developed as an information and assessment tool for individuals interested 
in birds, mammals, reptiles and amphibians in Michigan. The wildlife information section 
provides data on wildlife species distribution by county, habitat requirements, a habitat 
use matrix, and citations from pertinent literature. The wildlife habitat assessment section 
of MIWILD is hierarchical. Assessments can be conducted at several levels of resolution; 
from broad-scale cover type to fine-scale cover type/developmental stage and within-
stand features.  

Information sources 
MIWILD was developed based upon additional literature review and the incorporation of 
comments from the Michigan Gap project.  Additional literature reviews were conducted 
by faculty and students at Grand Valley State University.  Sources include the Birds of 
North America species accounts (American Ornithologists Union), the Mammalian 
Species accounts (American Society of Mammalogists), and pertinent research articles.  
The literature review was not comprehensive but included many more additional sources 
than the original software.   



 

 

How to use the MIWILD program 
MIWILD is a database containing species lists and occurrence by habitats. The habitats 
include a full range of land cover types using two different modified Anderson 
classifications (IFMAP and NED).  The forest classifications are much more detailed, 
including breakdowns into size classes including regeneration, sapling, pole, small 
sawlog, large sawlog. 
 
This is the main interface of MIWILD.  The species list is on the left side of the screen 
and the habitat tabs are on the right side of the screen.  The habitat tabs consist of the 
County Maps, the Forest and Non-forest Types, and the Habitat Features screens. 
 

 
 



 

 

The Species List 

 
 
There are 399 vertebrate species in MIWILD, 22 amphibians, 30 reptiles, 287 birds and 
60 mammals.  This is a fairly extensive list and includes not only year-round residents 
like raccoons but also seasonal residents like neo-tropical migrants that breed in the state 
(e.g. Scarlet Tanager), a few that only winter in Michigan (e.g. American Tree Sparrow), 
and those species that may briefly stop in Michigan on migration between wintering and 
breeding grounds (e.g. numerous shorebirds). 
 
At the bottom of the list is the count of how many species are selected.  If you only see 
two numbers, the first is the number selected and the second is the total number of 
species in MIWILD.  If you see three numbers, they are the number selected, the number 
being displayed and the total number of species in MIWILD.   
 
An information page can be displayed for each selected wildlife species by accessing the 
Help Menu or by simply pressing the [F2] key.  The page is an HTML file and is 
displayed in your default browser.  The information page includes pertinent literature 
relating to species habitat requirements.  The information page also contains what we call 
a “rule” .  A rule is a verbal statement depicting the habitat requirements of the species.  
In MIWILD there are two rules for each species – one based on the IFMAP classification 
and the other the NED classification. A complete list of potential cover types used by the 
species is included after the rule.  



 

 

The  button displays the following dialog: 
 

 
 
This allows the user to modify the list of species displayed.  For example, if you are only 
interested in Birds, you may un-check Amphibians, Reptiles and Mammals.  It is fairly 
easy to make selections here that would result in no species being displayed.  For 
example, if you un-check all the species groups, the result will be an empty list.  If that 
happens, the dialog will warn you when you press the ‘OK’ button.   
 
The selections on the right allow you to change the sort order of the species and the 
display of the species name.  If you are displaying common names, there are two 
alphabetical options.  The following table shows how a list of species will be sorted by 
both options: 

Alphabetically by first 
name 

Alphabetically by last 
name 

American Goldfinch Red Crossbill 
Evening Grosbeak White-winged Crossbill 
House Finch House Finch 
Pine Grosbeak Purple Finch 
Pine Siskin American Goldfinch 
Purple Finch Evening Grosbeak 
Red Crossbill Pine Grosbeak 
White-winged Crossbill Pine Siskin 

 
In this case, the ‘last name’ sort may be desired so that related birds (i.e. the Crossbills or 
the Grosbeaks) are together on the list. 
 
The bottom checkbox in the dialog will expand the species list so all species are 
displayed.



 

 

The  button will display the following dialog: 
 

 
 
The species are sorted alphabetically by first word in the name.  If you check the ‘Latin 
names’ checkbox, the latin name will be shown first and the list is re-sorted.  You can 
select an individual species by clicking its checkbox, or use the buttons on the right to 
modify the list.  The first two buttons will select everything or un-select everything.  The 

 button will check all species that are not currently selected and un-check 
all species currently selected. 
 
The four species group buttons (Amphibians, Reptiles, Birds and Mammals) add to the 
selected species, so pressing ‘Amphibians’ and then ‘Mammals’ will result in species 
from both groups being selected. 



 

 

The bottom two buttons allow you to import or export the selected species from/to an 

ASCII file.  The  button will display the following dialog: 

 
 

When you open a file using the  button all species names found in the file will be 
listed.  The program looks for common name, Latin names or species codes.  The file 
does not have to be in any fixed format.  For example, if the input file contained the 
following paragraph: 

 
Northern Leopard frogs were associated with permanent ponds.   Wood frogs 
were absent from permanent ponds and were common in temporary ponds.  
American Toads were found in both permanent and temporary ponds.  All three 
are prey items to birds of prey such as the Broad-winged Hawk and Eastern 
Screech-Owl. 

 
The resulting list would look like this: 

 
 
The species names in the file must match the names in MIWILD or they will not be 
recognized.  Once in the list, individual species can be un-checked if you do not want 
them selected. 
 



 

 

The  button will display the following dialog: 

 
The species listed on this dialog will only be those currently selected, not the entire 
species list.  You can un-check individual species if you do not wish for it to be exported.  
The resulting ASCII file will contain a single line for each species.  The contents of each 
line depends on what fields you have checked.  When you check a field, it will be added 
to the list in the middle of the dialog.  You can click and drag the fields to determine the 
order in the output file.  If you check the ‘Output header line at top of file’ checkbox, the 
first line in the file will contain the field names.  The block at the lower left of the dialog 
determines what character is used to separate the fields.  You can choose a tab, comma, 
semicolon or a character of your choice.  If the “Put fields within quotes” checkbox is 
checked, the output fields will be within quotes.  For example, the output of the above 
dialog would be an ASCII file containing the following: 
 
Code,Common,Latin 
"AAABB01020","American Toad","Bufo americanus" 
"ABNKC19050","Broad-winged Hawk","Buteo platypterus" 
"ABNSB01030","Eastern Screech-Owl","Otus asio" 
"AAABH01170","Northern Leopard Frog","Rana pipiens" 
"AAABH01200","Wood Frog","Rana sylvatica" 



 

 

The  button will display the following dialog: 
 

 
 
When the search string is empty, all species will be listed in alphabetical order.  Enter a 

search string and press the  button to display a subset of species.  For example, 
here are the results of searching using the string “blue”: 

 
 
Any species containing the string will be displayed.  When you find the species you want, 
double-click it in the list and it will be found on the main screen.  You can enter any 
string, and matches will be found using either the common or latin name. 
 



 

 

The County Screen 

 
The first screen that is displayed on the right is the state county map.  The county maps 
are used for species distributions – what species may be located in that particular county.  
For instance, the database limits the distribution of moose to the counties of the Upper 
Peninsula while the Prothonotary Warbler, a southern species associated with bottomland 
hardwood forests would only be found in the southern counties of the Lower Peninsula. 
 
When you click on a county, the name appears on the status-bar at the bottom of the 
screen.  To select a county, double-click it on the screen.  A selected county will be gold 
colored.  The number of selected counties will be displayed in the upper-right corner of 
the screen.  You can display a county information page by using the “Help” menu and 
selecting the second item, or by pressing the [F3] key.  The page will list all species 
found in that county.  
 
 



 

 

The  button will display the following dialog: 

 
 
The counties are listed alphabetically and the user can select individual counties using the 
checkboxes.  The user can also use the buttons on the right to modify the selected 

counties.  The first two buttons will select all or clear all selections.  The  
button will check all counties that are not currently selected and un-check all counties 
currently selected. 



 

 

The Forest Types screen 

 
There are two forest classifications available; IFMAP and NED.  IFMAP contains 
approximately 140 land cover classes in IFMAP.  There are approximately 65 NED land 
cover classes in Michigan.  For a list of the forest types and their definitions see 
Appendix A for the IFMAP types and Appendix B for the NED types.   
 
To select or un-select an individual forest type/size class combination, double-click on a 
white cell.  If you double-click a row header, all size classes of a forest type will be 
toggled on or off.  If you double-click a forest type that has sub-types, all of the sub-types 
are toggled on or off.  For example, if The “Oak” type is selected, all sub-types (from 
“Oak, Hickory” to “Mixed Oak”) will be selected. 
 
The count of selected and total number of types are displayed in the upper right of the 
screen.  You can display a habitat information page by using the “Help” menu and 
selecting the second item, or by pressing the [F3] key.  The page will list all species 
found in that forest type.  



 

 

The  button will display the following dialog: 

 
 
The types are listed alphabetically and the user can select individual types using the 
checkboxes.  The buttons on the right can be used to modify the selected types.  The first 

two buttons will select all or clear all selections.  The  button will check 
all types that are not currently selected and un-check all types currently selected. 



 

 

The Non-forest types screen 
 

 
 
The Non-forest cover type screen includes both the IFMAP and NED classifications.  It 
includes those non-forested types like agricultural, residential, wetlands, brush-lands, and 
water.   
 
To select or un-select an individual type, double-click it on the list.  Selected types will 
be bold-face. 
 
The count of selected and total number of types is displayed in the upper right of the 
screen.  You can display a habitat information page by using the “Help” menu and 
selecting the second item, or by pressing the [F3] key.  The page will list all species 
found in that cover type.  
 



 

 

The  button will display the following dialog: 

 
 
The types are listed alphabetically and the user can select individual types using the 
checkboxes.  The user can also use the buttons on the right to modify the selected types.  

The first two buttons will select all or clear all selections.  The  button 
will check all types that are not currently selected and un-check all types currently 
selected. 



 

 

The Habitat features screen 
 

 
 
The Habitat Features are within stand features.  They include such things as cavity trees, 
dead down woody debris, and vernal pools.  For a list and descriptions of the habitat 
features, see Appendix C.   
 
To select or un-select an individual feature, double-click it on the list.  Selected features 
will be bold-face. 
 
The count of selected and total number of features are displayed in the upper right of the 
screen.  You can display a habitat features information page by using the “Help” menu 
and selecting the second item, or by pressing the [F3] key.  The page will list all species 
associated with that habitat feature. 
 
 



 

 

The  button will display the following dialog: 

  
 
The features are listed alphabetically and the user can select individual features using the 
checkboxes.  The user can also use the buttons on the right to modify the selected habitat 

features.  The first two buttons will select all or clear all selections.  The  
button will check all habitat features that are not currently selected and un-check all 
habitat features currently selected. 



 

 

The Arrow Buttons  
 

 
 

There are four buttons at the center of the screen that control searches.  The  button is 

used to search from the Habitat Screens to the Species List.  The  button uses the 
species list to search for counties or habitats.  When either of those two buttons is used 

the selections are frozen as a reminder of the last button pressed.  The  button is used 

to break the connection between screens allowing for new selections.  The  button is 
used to clear all selections on both sides of the screen. 
 
 
The following examples illustrate the use of the arrow buttons. 



 

 

Example 1: Using a Wildlife Species to Find Habitats 
 
Example: Find the forested habitats for the Black-throated Blue Warbler.   
 
 
1.  Press the "Forest type" tab along the top of the habitats part of the screen.  This 
displays the forested habitat screen. 

2. To clear any previous selections, press the  button 
3.  Select Black-throated Blue Warbler in the animal list.  To find it quickly, use the 

 button, enter “blue” as the search string and press the ‘Search’ button.  Double-
click “Black-throated Blue Warbler” from the short list.  This will find the species on the 
main screen, but you will still need to select it by double-clicking.  If it does not show up, 

it probably is not in the currently displayed list.  Use the  and select “All 
available species” and make sure “Birds” is checked, and then try this step again. 
 
4.  Once selected, you can display an information page by pressing the [F2] key, or 
selecting “Black-throated Blue Warbler Information Page” from the “Help” menu. 

5.  To initiate the search of the matrix, click the  button.  The forested habitats for 
Black-throated Blue Warbler are checked.   
 
 
 
Notes: 
 
· In this example, only one wildlife species was chosen.  However, you may select 
multiple species for evaluation.  If multiple species are used, the grid will contain the 
number of species in each forest type/size class combination.  If a cell is double-clicked, 
the species list for that forest type/size class will be displayed along with options for 
saving the species list in an ASCII file. The counts will go away when the connection 
between the screens is broken.   
 
- The other arrow button becomes disabled as a reminder of which arrow was last 
pressed.  You cannot change any selection on either side unless the connection between 

the screens is broken, either by pressing the  or  buttons, or by trying to select 
either another species or another forest type. 
 
· To search counties or other habitat types, select the appropriate tab in step 1 and 
continue with steps 2 to 5. 



 

 

Example 2: Using Several Wildlife Species to Find Habitat Features 
 
Example: Find the habitat features for all woodpeckers.   
 
 
1.  Press the "Habitat features" tab along the top of the habitats part of the screen.   

2. To clear any previous selections, press the  button 

3.  Select the woodpeckers in the animal list.  To find them quickly, use the  
button, enter “woodp” as the search string and press the ‘Search’ button.  Double-click 
one of them from the resulting short list.  This will find the species on the main screen, 
but you will still need to select them by double-clicking on each woodpecker.  If they 

don’t show up, they probably are not in the currently displayed list.  Use the  
and select “All available species” and make sure “Birds” is checked. 

4.  To initiate the search of the matrix, click the  button.  The features for 
woodpeckers are in bold-face.  The numbers after the feature names are the number of 
using each feature.  If a feature is double-clicked, the species list for that feature will be 
displayed along with options for saving the species list in an ASCII file. The counts will 
go away when the connection between the screens is broken.   
 
 
 
Notes: 
 
- The other arrow button becomes disabled as a reminder of which arrow was last 
pressed.  You cannot change any selection on either side unless the connection between 

the screens is broken, either by pressing the  or  buttons, or by trying to select 
either another species or another habitat feature. 
 
· To search counties or other habitat types, select the appropriate tab in step 1 and 
continue with steps 2 to 4. 
 
- You don’t need to enter the complete search string in step 3.  In this case the string 
“woodp” is enough to isolate the woodpeckers.  However, the “Northern Flicker” and 
“Yellow-bellied Sapsucker” don’t show up in the list since they don’t contain “woodp” in 
their names. 



 

 

Example 3: Using Habitat Selections To Search For Species 
 
Example: Find the species associated with large sawtimber oak-hickory. 
 
1.  Press the "Forest types" tab along the top of the habitats part of the screen. 

2. To clear any previous selections, press the  button 
 
3.  Find the row for “oak-hickory” and double-click the cell under the “Lg Saw” column.  

You can use the  button on the habitat screen to find the forest types sorted in 
alphabetically order.  If you check oak-hickory in the list, when you return to the main 
screen all size classes will be selected.  Double-click individual cells to toggle the 
selections on or off.  

4.  To initiate the search of the matrix, click the  button.  The species corresponding to 
the habitat type will be selected.  
 
 
If you wanted to generate a file containing the resulting species list, take the following 
steps: 

5.  Press the  button above the species list.  It the program prompts you to 
break the connection between the screens, press ‘Ok’. 
 

6. Press the  button to bring up the export Species List dialog. 
 

7. Press the  button to specify an output file.  Select what fields (Common name, 
Latin name, etc.) you want to output.  Specify if you want a header line at the top of the 
file, the separator between fields and whether or not you wish quotes around the fields.  
When you press ‘Ok’ your file will be created. 
 
Notes: 
 
- The other arrow button becomes disabled as a reminder of which arrow was last 
pressed.  You cannot change any selection on either side unless the connection between 

the screens is broken, either by pressing the  or  buttons, or by trying to select 
either another species or another habitat feature. 
 
· To search using counties or other habitat types, select the appropriate tab in step 1 and 
continue with steps 2 to 4. 
 
- The output file created in step 7 is a simple ASCII file that can be opened by almost any 
software package.  The file can also be used to select species in the Import Species List 
dialog. 
 



 

 

Example 4: Combining searches between habitat screens 
 
Example: Find the species associated with large sawtimber oak-hickory that use Dead 
Down Woody Debris. 
 
 
1.  Press the "Forest types" tab along the top of the habitats part of the screen. 

2. To clear any previous selections, press the  button 
 
3.  Find the row for “oak-hickory” and double-click the cell under the “Lg Saw” column.  

You can use the  button on the habitat screen to find the forest types sorted in 
alphabetically order.  If you check oak-hickory in the list, when you return to the main 
screen all size classes will be selected.  Double-click individual cells to toggle the 
selections on or off.  

4.  To initiate the search of the matrix, click the  button.  The species corresponding to 
the habitat type will be selected.  
 

5. Press the  button.  It the program prompts you to break the connection 
between the screens, press ‘Ok’. 
 
6. On the species list dialog, select the ‘Currently selected species only’ option under the 
‘Modify the species being displayed’ group.  The resulting list is only those species 
associated with oak-hickory. 

7.  Clear all previous selections using the  button 
 
8.  Press the ‘Habitat features’ tab along the top of the habitats part of the screen. 
 
9. Double-click “Dead Down Woody Debris” to select it on the habitat features list. 

10.  To initiate the search of the matrix, click the  button.  The resulting selected 
species are those associated with oak-hickory and Dead Down Woody Debris. 
 



 

 

Building matrixes 
 
Occasionally the user may want a 2x2 matrix of search results.  The “Output Matrix” 
option in the “File” menu is used for this purpose.  When you select ‘Output Matrix” 
from the ‘File’ menu the following dialog is displayed: 
 
 
 
 
 
 
 
 
 
 
 

 
 
You can select which axis holds what with the first pair of radio-buttons.  The ‘Column 
delimiter’ is used between the cells of the matrix.   
 



 

 

The cell contents section is where you specify what you want displayed in the individual 
cells of the matrix.  By default, those cells where the species is found is set to “yes” and 
all other cells are left blank.  But you can do whatever you want.  The “Use habitat notes 
if there are any” will display notes from the rules instead of the specified string.  There 
are some comments such as “Provided that small woodlots are present” for Low Intensity 
Urban by Cooper’s Hawk.   
 
At the bottom of the screen you specify where you want the results placed.  If you select 
‘ASCII file’, a file name dialog will pop up to specify an output file.  The ‘Clipboard’ 
option is the default.  After the matrix is built it is output directly to the Windows 
clipboard.  You can jump right to Excel or Word and paste it in. 
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